
 Configuring iSupport Views, Charts, and Alerts

Use the Desktop Content  icon on the Desktop to access the Alert, Chart, and Standard and Report View 
Designers, as well as the Content Manager. 

• Use the  Report View Designer to create a report view with calculated counts, percentages, sums, averages, 
minimums, and maximums on all selected fields. Use the  Standard View Designer to create a standard view 
with a few calculated fields but no calculated counts, percentages, sums, averages, minimums, and maximums 
on selected fields. See “Using the View and Report Designers” on page 2.

• Set up alerts to appear in the Desktop Notifications list (and popup if configured) when a view field reaches a
certain threshold via the  Alert Designer. See “Creating Alerts” on page 15.

• Select  Chart Designer to set up a chart for display in the Chart component on the Desktop; see “Using the 
Chart Designer” on page 18. You can set up a chart for display on mySupport via the Content Manager; see 
below.

• Use the  Content Manager to:

• Configure alerts. See “Creating Alerts” on page 15.

• Add, delete, and rename dashboards, set dashboard access, and automatically add a dashboard for all
support representatives. See the online help for more information.

• Manage charts. Display lists of default and custom charts and create, copy, and open charts in the Chart
Designer. (Note that you can only copy charts included in iSupport by default; the Edit button will not appear.)

The Shared folder contains items that have been designated as shared or are included in iSupport by default. 
The items under My Views and My Charts are those that you have personally created. 
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Rep Work Item charts enable you to display data in area, stacked area, bar, stacked bar, column, and 
stacked line format for tracking incidents, problems, changes, and purchase requests for a specified time 
frame. 

Rep charts enable you to display data on any view field. You can create a gauge, bar, line, pie, or area chart.

mySupport charts have the same configuration fields as Rep charts, but can only appear on the mySupport 
portal.

See “Using the Chart Designer” on page 18 for more information.

• Manage standard and report views. Display lists of default and custom views and create, copy, and open 
items in the View Designer. (Note that you can only copy views included in iSupport by default; the Edit button 
will not appear.)

The Shared folder contains items that have been designated as shared or are included in iSupport by default. 
The items under My Views and My Charts are those that you have personally created.

 A green dot indicates that the item is available for display; a red dot  will appear if a view or chart is 
disabled. Note that support representative permissions may prevent display of views and charts.

 Views can be enabled for display on a mobile device; this will cause the content to appear in rows instead 
of columns. Note that mySupport portal views are automatically mobile-enabled. 

 A Read indicator is enabled; use the  button to disable it. 

* An asterisk indicates that alerts and/or charts have been created from a view.

Using the View and Report Designers
Use iSupport’s View and Report Designers to create a view of iSupport data that you can display on the Desktop and 
export in Microsoft® Excel (*.xls), Microsoft® Word (*.doc), Portable Document Format (*.pdf), or Comma Separated 
Value Format (*.csv). (Note that this feature requires that the Enable 32-Bit Applications setting is enabled for the 
application pool associated with iSupport.) You can create a new view or make a copy of an existing view and modify 
it to create a new view. (Note, however, that you cannot modify shared views included by default in iSupport.) You 
can utilize iSupport’s predefined data fields or any custom SQL views/queries that you have created.

Access the View and Report Designers via the Standard View Designer and Report View Designer options on the 
Desktop Content menu, the Create  icon in the View Component, the Edit  icon next to views you create or 
shared views (except those included by default in iSupport) in the View Component, and buttons that display after 
selecting a view in the Content Manager. 

Use the View Tour link in the upper right corner of the screen to display a short series of tips.
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Configuring Basic Settings
Click the Show Advanced Settings link to configure settings that affect the entire report.

In the Subfolder section, enter the name of the folder in which to place the view in the Content Manager and in view 
lists. This folder will be placed under the folder named after the data source selected for the view.

There are two view types:

• Standard views contain a few calculated fields (under the Aggregates field section) but do not enable you to 
configure calculated counts, percentages, sums, averages, minimums, and maximums on selected fields. See 
“Configuring a Standard View” on page 6 for more information.
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• Report views enable you to configure calculated counts, percentages, sums, averages, minimums, and 
maximums on all selected fields. See “Configuring a Report View” on page 11 for more information.

In the Data Source field, select the type of data on which the view will be based. The Config options in the dropdown 
list correspond to functionality enabled in the Configuration module. 

Use the Design Custom View link next to the Data Source Field to utilize any custom SQL views/queries of iSupport 
data. The Custom Table or View Name field appears for you to enter the name of the query or custom SQL table of 
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iSupport data. Click the Load Columns button to display the fields available for the view. Use the Design Standard 
View link to redisplay the Data Source field.

The Enabled Read/Unread field appears for incident, problem, change, and purchase views. In a view with the read/
unread function not enabled, all folders are blue. Select Yes to display:

• A green  icon next to an unread item or a folder with both unread and updated items.

• A yellow  icon next to a folder with at least one updated item. 

• A blue  icon next to a closed or read item or a folder with both closed and read items. 

Right-click on a folder to display Mark All Read and Mark All Unread options. 

Select On in the Text Wrapping field to, for all text fields in the view, restrict the number of lines that display in a cell. 
The maximum number you can enter in the Max lines Per Row field is 10.

Configuring Permissions and Sharing
In the Enabled field, select No if you wish to prevent the view from being included in the Chart Designer, Alert 
settings screen, and in the list of views available for selection in the View dropdown field in the tab content 
configuration dialog. Views can also be disabled in the Content Manager, and are indicated by a red dot:

The Enabled for Mobile field appears in the View Designer for rep views (mySupport views as they are automatically 
optimized for display (with rows instead of columns) on a mobile device). Select Yes to enable the view for display on 
a smart phone (iOS, Android, or Blackberry) or tablet to access iSupport. Views can be disabled for mobile use in the 
Content Manager.

In the Access field, select one of the following:

• For Rep Views:

• Myself to keep the view private so only you can add it to your Desktop. The view will appear in the My Views 
folder in view lists (for example, in the View dropdown field in the tab content configuration dialog). 

• Shared to make the view available for other support representatives to add to their Desktops. You can click 
the Configure link in the View Designer to restrict access to the view to only specified support representatives 
and support representative groups. 

Note: If you designate a view as Shared, it will appear to you under in the My Views folder; the My Views folder 
contains views that you have personally created via the View Designer.
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• For mySupport Views: Click the Configure... link to select the customer groups and/or individual customers that 
can display the view.

If displaying settings for an existing view on which one or more charts have been defined, the charts appear in 
the Associated Charts dropdown along with an Edit link. You can select a chart and click the Edit link to display 
the chart settings in the Chart Designer.

The For Records Pending Deletion field appears for data sources that have pending deletion functionality (Assets, 
Companies, Config - Categories, Config - SLAs, Config - Support Representatives, Customers, and Survey Requests).

Records pending deletion have been deleted by an iSupport user but are retained in the system because of 
references to other records (incidents, correspondence, etc.) The Database Maintenance agent ultimately removes 
the record. Use the For Records Pending Deletion field to specify whether to include, exclude, or include only records 
pending deletion.

Configuring a Standard View
Standard views contain a few calculated fields (under the Aggregates field section) but do not enable you to configure 
calculated counts, percentages, sums, averages, minimums, and maximums on selected fields. See “Configuring a 
Report View” on page 11 for information on configuring a Report view.

The following sections reference creation of a custom rep view named This Week’s Priority Open Incidents:
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The data source fields available for the view appear in the navigator on the left; drag the applicable fields to the 
applicable section on the right. Note: The Date Generated field in the Incident source contains scheduled ticket 
information.

To sort the report and display a data source field as a folder on the left side of the view, drag the field into the Folders 
section. Any folders after the first folder will appear as a subfolder in the view.

Drag the data source fields that you wish to display as columns in the Columns section; columns listed will appear in 
order from left to right.
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Click the Configure  icon next to a column field to format how it will appear in the view. 

In the Header Text field, enter the text labeling the folder or column. 

In the Null Text field, enter the text to appear when the data value in the view is nothing or zero. 

The Yes/No Text field appears for data source fields that have a True/False value; enter the text to appear for the 
True/False values.

The Aggregate field will appear for date and number fields; you’ll have the option of specifying Sum, Average, 
Minimum, or Maximum. If any of these options are selected for a field, the applicable total calculated value for the 
folder will appear at the bottom of the view component as well as in view rows. Note that the calculated values that 
appear at the bottom of the view component will not be included in a view export.

Click Edit in the Column Format field to configure the date format, font and alignment of values in an entire column, 
and the format of values that meet specified parameters. 

• The Data tab appears for date fields; use it to configure display of the day, month, year, and time.
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• Use the Font Styles tab to set the horizontal alignment, font style, font color, and fill color for all of the data in 
the column.

• Use the Conditional Formatting tab to base data formatting on set parameters. Select the comparison method, 
enter the value to be used with it, and then select the font style, font color, and/or fill color. If a value meets the 
specified condition, it will display in the specified format. Formatting will not apply to hidden columns.

The Apply to Row option can be configured for more than one field in a row; if a row contains more than one field 
that meets its conditions, the formatting of the field that has the lowest column display order number will be 
used for all fields except those that have their own formatting. Entire row formatting only applies to fields that do 
not have individual formatting. 

In this example these settings will appear as follows:

The Source field contains the original name of the data source field.
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Setting the Sort Order and Direction

Drag the fields on which the view should be sorted into the Sorting section, in the order (from top to bottom) in which 
the fields should be sorted relative to the rest of the fields in the view. 

• Ascending  to sort field values in order from first to last/lowest to highest (alphabetically A-Z, lowest number 
to highest number, or in the case of Priority, Low to Emergency).

• Descending  to sort field values in order from last to first/highest to lowest (alphabetically Z-A, highest 
number to lowest number, or in the case of Priority, Emergency to Low).

In the example below, incidents are sorted first by priority and then date created.

Setting Filters

Use the Filters tab to set parameters for minimizing the amount of data that appears in the view. Select the field for 
which data should be minimized; comparison methods applicable to the field will appear in the dropdown. Select the 
comparison method and then enter the value to be used with it if applicable. Use the Match <All/Any> field to specify 
whether you want every <field> <comparison method> <value> condition to be met, or any configured condition to be 
met. Use the Add Condition  and Remove Condition  icons to display and remove a <field> <comparison 
method> <value> condition. Click the Add Condition  icon if you wish to include another condition. You can use the 
Add Condition Group  icon to put a set of conditions to be evaluated together in a group. 

Note: If a date field is selected, the Between comparison method does not include beginning and ending dates. The 
Current Week method is based on a Sunday through Saturday time frame.

In the following example, the view will only include incidents with an open status.

Sort Order 2: By Date Created in Ascending Order

Sort Order 1: By Priority in Descending Order
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This example view also includes a filter on the date created; the view will only include incidents with a creation date 
within the current week.

The view will save the filter immediately; click the Apply button to update the preview.

Previewing Your View

Use the Preview area to display your view; click the Expand link to display the view full-screen. Note: If using System 
BIOS fields in the Asset Scans - Inventory data source, some values may not be populated; some system vendors do 
not provide this data in the WMI system profile.

Working with Columns

To resize the width of a column, drag your cursor on the column edge to the desired width; the width in pixels will 
appear in a tooltip.

You can also resize columns when displaying views in a Desktop component.

Configuring a Report View
Report views include calculated counts, percentages, sums, averages, minimums, and maximums on selected fields. 
Many of the options used to configure sorting, display order, etc. are the same as in standard views, but you’ll use a 
Folder and Row Groups section to configure folder level sorting, a Calculated Fields section to configure display of 

Width appears in the view when you resize a column
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count and percentage values, and an Aggregate Fields section to configure display of sums, averages, minimums, and 
maximums. 
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The following sections reference creation of a custom rep view named Incident Counts by Rep:

Adding Folder and Row Groupings

Use the Folder and Row Groups section to select the fields on which the view is based; all other columns of counts 
and percentages, as well as sums, averages, minimums, and maximums will reference these fields. In this example, 
the view will display counts and the average time open for each assignee’s incidents. 

You can use the Folder Level column to display a view field as a folder in the left navigator; enter the number for the 
position of the field.

Adding Calculated Fields

Use the Calculated Fields section to add a column with a count or percentage. Select fields for this section via the Add 
link and then click the Edit link in the Conditions column to set criteria for those fields. Use the Match <All/Any> field 
to specify whether you want every configured condition to be met, or any configured condition to be met. To 
configure a condition, click the Select a Field link and select a field; comparison methods applicable to the field 
appear in the dropdown. Select the comparison method and then enter the value to be used with it. Use the Add 
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Condition  icon to add another condition, or the Add Condition Group  icon to include a set of conditions to be 
evaluated together in a group.

This example will include a count of the assignee’s incidents with an open status, a count of the assignee’s incidents 
with a suspended status, and a count of the incidents that were closed on the current day.

Adding Aggregate Values

Use the Aggregate Fields section to add a column that displays the minimum, maximum, sum, or average values for a 
selected field. Use the Add link to select fields for this section. 

Use the Filter section to configure conditions for restricting and minimizing data in the entire view (including fields 
configured in the Aggregate Fields section). In this example, incidents that either have an open status or have been 
closed on the current day will be included in all values in the view.

In the Filter section, use the first Match <All/Any> field to specify whether you want every configured condition to be 
met, or any configured condition to be met. To create a condition, click the Select a Field link and select a field, 
aggregate value such as total time worked, or event attribute such as whether an incident has been acknowledged. 
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Then select values applicable to the selected field. You can use the Add Condition Group  icon to include a set of 
conditions to be evaluated together in a group.

Ensure that the filter won't conflict with your count conditions, as the overall filter will override any defined count 
conditions. For example, if you have a count condition based on a date created within the current year but then 
define an overall filter for a date created equal to the current month, the column that has the condition of current 
year will only display the count of incidents for the current month because the overall filter will apply.

Creating Alerts
Alerts appear in a desktop notification (and popup if configured) when a view field reaches a certain threshold; for 
example, you can configure an alert to appear when a certain number of Emergency priority incidents has been 
reached. Alerts can also be sent via email and page, to multiple support representatives and/or support 
representative groups. Select an alert desktop notification or the View button in the popup to display details. 
Acknowledge the alert to remove it from the desktop notification list.

Support representatives with the Create Personal Alert permission, you can access the Alert configuration screen via 
the Alert Manager option on the Notifications menu, Alert  icon in View and Chart components, and the Alert 
button in the View Designer and Chart Designer. If you have the Edit Shared Alert permission, you can modify an 
alert that is configured to appear for multiple support representatives and/or support representative groups. Alert 
criteria is evaluated based on the schedule of the Alert agent, so be sure to schedule the Alert agent in the Options 
and Tools | Administer | Agents screen.
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Use the Alerts tab in the Content Manager to display the following screen for configuring and managing alerts. You 
can click the Reinstate link to force the alert criteria to be evaluated the next time the Alert agent runs.

Step 1 - As with charts, alerts are based on view values; use the View field or the Chart field to select the view or 
existing chart on which to base the alert. If you select an existing chart, the view and value on which it is based will 
appear. 

The values in the view appear in the Step 2: Select a Value to Chart section; select the value to be used as the basis 
for the alert. For example, if configuring an alert to appear when a certain number of Emergency priority incidents 
has been reached, you would select Emergency.

Use the fields in the Step 3: Configure Alert Parameters section to specify the title, criteria, and notification options.

Alert Title - Enter a name for the alert.

Comparison Type - Select the condition that will use the value in the Threshold field to trigger the alert: Greater 
Than, Equal, Less Than, Less than or Equal, or Greater Than or Equal.

Threshold - Enter the number that will be used by the value in the Comparison Type field to trigger the alert.

Reinstatement Interval - After an alert is acknowledged, enter the number of hours after which the alert criteria 
should be automatically evaluated (based on the schedule of the Alert agent). The alert criteria will also be evaluated 
when a support representative clicks the Reinstate link in the alert display frame.
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Current Value - The current number of view items appears; for example, if your view is based on incidents, the 
current number of incidents appears. 

Alert via Desktop - Select On to display the alert in the Notification Center list (and popup, if configured in 
Preferences) of those configured in the Send To field:

• All support representatives (if none are selected)

• Only support representatives and/or support representative groups designated in the Send To field 

Alert via Email - Select On to send an alert email to the support representatives and/or support representative 
groups designated in the Send To field. The email will contain the following by default:

Subject: [iSupport] <alert name> Alert Met

Body: Threshold of <comparison type> <threshold> <data source> for <selected value to monitor> met.

Email Custom Notification - Select No Notification to send no notification, iSupport Default to use the default 
notification text, or select a custom notification; use the Create New  and View/Edit  icons to access the Custom 
Notification screen. 

Alert via Pager - Select On to send an alert page to the support representatives and/or support representative 
groups designated in the Send To field.

Pager Custom Notification - Select No Notification to send no notification, iSupport Default to use the default 
notification text, or select a custom notification; use the Create New  and View/Edit  icons to access the Custom 
Notification screen. 

Send To - This field appears if you have the Create Shared Alert permission. Click the Configure link to display a 
screen for selecting the support representatives and/or support representative groups that should receive the alert 
when the criterion is met. 

After you click Save, the alert appears on the Desktop as shown below:

When an alert is triggered, the colors will change according to the legend. 
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After acknowledging the alert, the alert appears as shown below in the Content Manager:

You can click the Reinstate link in the alert display frame to force the alert criteria to be evaluated the next time the 
Alert agent runs after the reinstatement interval has started. 

If the “The underlying view has changed. Edit alert to correct.” color appears, it is because an alert was based on a 
column in a view and then that column was later removed from the view. Select the alert in the Title column to 
change its settings.

Deleting Alerts
If you have the Delete Private Alert permission, you can delete an alert that you have created. If you have the Delete 
Shared Alert permission, you can delete an alert that is sent to support representatives and support representative 
groups (configured via the Send To field). Note that you will need to remove any support representatives and/or 
support representative groups in the Send To field before you can delete an alert. 

Configuring Charts
Use the Chart  component to display an area, bar, column, line, pie, or scatter chart configured via the Chart 
Designer. If Opportunity functionality is enabled in the Feature Basics screen, you can configure funnel-type charts 
via the component configuration dialog. Two types of Desktop charts can be configured via the Chart Designer: Rep 
charts and Rep Work Item charts. 

• Rep Work Item charts enable you to display data in area, stacked area, bar, stacked bar, column, and stacked 
line format for tracking incidents, problems, changes, and purchase requests for a specified time frame. You can 
set colors and multiple chart parameters and time frame types such as quarterly and yearly trending. 
(Configured Rep Work Item charts will appear in the component configuration  dialog in a Work Items folder.)

• Rep charts enable you to display data on any view field; you can create a gauge, bar, line, pie, or area chart. 

Using the Chart Designer
Use the Chart Designer to configure charts representing iSupport data for display in the Chart component on the 
Desktop and on the mySupport portal. You can restrict access to specified support representatives, customers, and/
or groups. 
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You can access the Chart Designer via the Chart Designer option in the Desktop Content menu, the New Chart button 
in the View Designer, the Edit  icon that appears next to existing charts in the Chart component configuration 
dialog, or the Edit and Copy links after selecting a chart in the Content Manager. 

Rep Work Item charts enable you to display data in area, stacked area, bar, stacked bar, column, and stacked line 
format for tracking incidents, problems, changes, and purchase requests for a specified time frame. You can set 
colors and multiple chart parameters and time frame types such as quarterly and yearly trending. See the next 
section for information on creating a Rep Work Item chart.

• Rep charts enable you to display data on any view field. You can create a gauge, bar, line, pie, or area chart. See 
“Creating a Rep Chart” on page 20 for information on configuring Rep charts.

• mySupport charts have the same configuration fields as Rep charts, but can only appear on a mySupport portal.

Creating a Rep Work Item Chart

Rep Work Item charts enable you to display data for an incident, problem, change, or purchase data field for a 
specified time frame. 

Access - Select Myself to keep the chart or gauge private so only you can display it on your Desktop or Shared to 
make the chart or gauge available for other support representatives for displaying on their Desktops.

Grouping - Select the field and field value(s) to chart for the specified work item type or select None to chart a count 
for the specified time frame. 
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Time Frame Type - Select the duration on which to chart the selected field values. 

Last - Select Yes to include data for past time frame intervals and then enter the number of intervals in the Last 
Interval field. In the example above, the chart will present data for the last 11 weeks.

Time Frame Start/End - This field appears if No is selected in the Last field. Select the dates for the time frame on 
which data should be presented. 

Colors - Select the colors to display for the values in the Values field. The order from top to bottom will correspond to 
the order in the Value field; in the example above, Low priority will be green, Medium priority will be purple, and so 
on.

Creating a Rep Chart

Rep charts enable you to display data on a configured view field. You can create a gauge for charting one view field 
value or a bar, line, pie, or area chart for depicting multiple value types if applicable for a view field. To get started, 
you’ll need to select the view on which to base the chart. If you select an existing chart, the view, value, and other 
parameters configured for the chart will appear; you can make changes and save with a different chart title. The 
values in the views appear under Step 2.

Use the dropdown in
the View field to select
one of your favorite
views, a shared view, or
a private view that you
created previously.

The values in the view appear here; it will change depending
on the display type. If you select a Chart display type, the
chart will depict multiple types of values (for example, all
types of priority).
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The values in the Step 2: Select a Value to Chart section change if creating a Gauge display type.

Use the fields in the Step 3: Configure Chart Parameters section to design the chart.

Display Type - Select one of the following:

• Chart to depict multiple types of values (for example, all types of priority) in the format of a bar, line, pie, or area. 
You can select one of the following: Bar, Line, Pie, and Area.

• Gauge to depict the amount of a specific value (for example, the number of emergency priority incidents) in the 
format of a thermometer or dial. You can select one of the following: Horizontal, Full, Half, and Quarter.

Chart/Gauge Title - Enter a name for the newly created chart or gauge. 

Max Gauge Value - This field appears if Gauge is selected in the Display Type field. Enter the number to appear at the 
top of the gauge.

Gauge Face Color - This field appears if Gauge is selected in the Display Type field and Full, Half, Quarter, Horizontal 
Thermometer, or Vertical Thermometer is selected in the Chart Type field. Select:

• Static to display a specified color for the gauge; the gauge will remain this color as the amount of the selected 
value changes. You can choose the color from the color selector or enter the hexadecimal color code.

• Dynamic to display a gauge that will change color (calculated along the color scale from blue to red) every time 
the amount of the value changes. If the current value exceeds the number entered in the Max Gauge Value field, 
the gauge will remain red.

Access - Select: 

• Select Myself to keep the chart or gauge private so only you can display it on your Desktop.

• Select Shared to make the chart or gauge available for other support representatives for displaying on their 
Desktops.

Sort Order - Select the direction in which to sort the chart: Ascending or Descending.
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Only Include the Top (Entity) Values Based on Total (View Entity) - If Chart is selected in the Display Type field, 
select on to only include a specified number of the top grouping. Then enter the number. For example, enter 10 to 
only include the top ten companies.

Only Include the First (Entity) Values Based Upon Total (View Entity) - If Chart is selected in the Display Type 
field, select On to only include a specified number of values, from the start of the list according to the specified sort 
order. Then enter the number. For example, if selecting incidents by followup date in descending order, enter 6 to 
only include the first 6 dates from newest to oldest date.
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